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Operation - Dialogs (Continued)

3-10.1.3 Save Configuration

Save configuration saves the current configuration of the SPS390 to a named
configuration file for subsequent recall by the Open Configuration command. The
save configuration includes:

» Current settings for the Acquisition Setup Dialog.

» Current settings for the Analysis Setup Dialog.

» Current settings for the Waterfall Setup Dialog.

» Current settings for an installed and invoked Signal Source Generator (SSG)
option.

» All current display windows.

W Sawve Configuration
File Name: Directories:
_ Opsn Sonfiguratls [*ctg c:\sd390
Save Configuration... Cancel
£ cfq_File
£ res
Save File as Type: Drives:
~ [ContigFilesi-cFe)  [¢] [=Ee: 12]
BO0n-24/ 20
&= The Save Configuration dialog is used to specify a particular configuration

file that will be saved on selected directories of the permanent storage
devices. The default directory and storage device is the current directory.
C:/sd390.

The Save Configuration dialog is used to create recallable data files that contain all
the settings of the SPS390 for a particular measurement. The SPS390 upon power
up will normally be configured in the factory default configuration. During the
course of a measurement process an operator may store the current configuration
that has been created by making changes to the Mode, Acquisition, Analysis,
Waterfall, Signal Source Generator (optional SSG), and Display pages. The Save
Configuration dialog allows the operator to store these changes for later recall and
reuse.

The Save File As Type: selection allows the operator to store configurations of
specific setups for use with other SPS applications. These types of configuration
files are also useful for specific measurements where the SPS390 operates in the
background.

List Files of Type:
Conlig Files(*.CFG]

BalancePro(*. AUT)
BalancePro(*.MAN])
BalancePro(*. NEW)]
BalancePro(*.TlA)
BalancePro(*.TIM)
BalancePro[=.VIB]
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%

The Config Files (*.CFG) are user defined SPS390 configuration files. These files
are exclusive to the SPS390.

The BalancePRO (*.AUT) file is the file used to perform the automatic data
acquisition of a machine run-up. While many of the settings are made for
specific machines or engines, generically the .AUT files are intended to store
magnitude and phase information in a waterfall file that is acquired on a delta
RPM basis. All of the changes made are made on the acquisition, analysis, and
waterfall pages. Display and screen changes are optional and not mandatory for
.AUT files to operate properly. For more information on these files see the
SPS610 BalancePRO Installation and Operation Manual, SPS document number
222856.

The BalancePRO (*.MAN) file is the file used to perform the manual data
acquisition of a machine or engine run-up. While many of the settings are made
for specific machines or engines, generically the .MAN files are intended to store
magnitude and phase information in a waterfall file that is acquired on a plus (+)
one basis at operator selected speed points. All of the changes made are made
on the acquisition, analysis, and waterfall pages. Display and screen changes
are optional and not mandatory for .MAN files to operate properly. For more
information on these files see the SPS610 BalancePRO Installation and
Operation Manual, SPS document number 222856.

The BalancePRO (*.TIA) file is a file used to perform an automatic acquisition of a
machine (or engine) run-up and coast down without a tach signal. While many of
the settings are made for specific machines or engines, generically the .TIA files
are intended to store Magnitude information in a Waterfall file that is acquired
on a Delta Time basis within a specified time frame. All of the changes made are
made on the Acquisition, Analysis, and Waterfall pages. Display and screen
changes will influence the overall level that gets reported for display readout. For
more information on these files see the SPS610 BalancePRO Installation and
Operation Manual, SPS document number 222856.

The BalancePRO (*.TIM) file is a file used to perform a manual data acquisition of
a machine (or engine) run-up or coast down without tach signal within a
specified time. While many of the settings are made for specific machines or
engines, generically the .TIM files are intended to store Magnitude information in
a Waterfall file that is acquired at specific operator selected speed points (+1)
within a specified time frame. All of the changes made are made on the
Acquisition, Analysis, and Waterfall pages. Display and screen changes will
influence the overall level that gets reported for display readout. For more
information on these files see the SPS610 BalancePRO Installation and
Operation Manual, SPS document number 222856.

The BalancePRO (*.VIB) file is the file used to perform the automatic data
acquisition of a machine run-up and/or run-down for a vibration survey. While
many of the settings are made for specific machines or engines, generically the
.VIB files are intended to store Magnitude and Phase information in a Waterfall
file that is acquired on a Delta RPM basis. All of the changes made are made on
the Acquisition, Analysis, and Waterfall pages. Display and screen changes will
influence the overall level that gets reported for display readout. For more
information on these files see the SPS610 BalancePRO Installation and
Operation Manual, SPS document number 222856.
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Operation - Dialogs (Continued)

3-10.1.4 Open Trace Data

Open trace data opens a specified data trace file for recall and display. The trace file
is read from disk and the data is displayed in a new display window, provided that a
new display window can be created. The display parameters are those that were
active when the data was saved (see figure below), although the X- and Y-Axis scales
are initially set to the default values of the display.

The name of the data file is selected by using the Open Trace Data Dialog.

f-; Open Trace Data
File Name: Directories:
[~tc c:\sd390
Cancel |
hammer.tic
square._tic
3 cfg_file
] res
List Files of Yype: Drives:
Tiace Files"TRC)  [¢] [= e B

EOEHD-35/21

&= If the maximum number of windows are already displayed on the screen,

this function will not be processed

3-10.1.5 Save Trace Data

Save trace data saves the data and display configuration for the specified display
window to a named data trace file for subsequent recall and display. The display
window is selected by moving the arrow cursor to the title bar of the desired window,
and clicking the selector button. The Save Trace Data dialog will then allow you to
name the file.

;w Save Trace Data !
File Name: Directories: :
lm c:\sd390

[P |2 =N 2] “
@2 $d390
¥ b
3
Save File as Type: Drives:
[Trace Files-TRO)  [#] [Ec: [#]

=

Compressed Time Displays cannot be Saved as trace data. See load
extended recording.
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3-10.1.6 Export Trace Data

Displayed data can be exported to other programs or other systems by using the

Export Trace Data function. The desired data is selected by moving the arrow cursor
to the title bar of the desired display window, and clicking the selector button.

= Export Trace Data
File Name: Divectories:
I'Alxt \sd390
7 B ;
bt = sd390
.. £ ctg_file
i Save Toace Dataie res
xpurt Trace Data...
| Laut Exdonded Revo
Save File as Type: Duayes:
Export Files(~ TXT) =X [_tj
UFF Files(*. UFF)
& Watariall Deta, |

606LL-36/32

The Export Trace Data Dialog will then allow you to name a file where the data is to

be placed. The data is stored on a disk file in ASCII format, in the displayed Units.
The format of the Export Files is described in this manual.

'

Compressed Time Displays cannot be Exported. The default directory and
storage device is the current directory, C:/sd390.

3-10.1.7 Load Extended Recording

Data from the SPS390 extended recorder memory that has been previously saved to
a named disk file is retrieved and loaded into extended recorder memory. The
acquisition and analysis parameters that were in effect when the data was saved are
also restored.

! . [ Load Extended Recording
et Configuration ]
B M“ File Name: Directories:
an c:\sd390
3 = c\ %
= :d390
&
*
List Files of Type: Diives:
Xiecoiding Files{*.XRC) L%j l c: @

When Load Extended Rec is selected, acquisition (and averaging), if active, is
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stopped. The Load Extended Recording dialog will then allow you to name the file
from which to retrieve the data.
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Operation — Dialogs (Continued)

Data from an extended recording disk file can be loaded at
any time. However, all current data and Acquisition and
Analysis Parameters are replaced by the saved data and
saved parameters. These parameters may not be
compatible with the current settings and may invalidate
the current Averager and Displays. Therefore, it's good
practice to stop acquisition before loading this data,
although this function will automatically stop acquisition
(and averaging) if active. Parameters that were in effect
when the data was saved are also loaded at this time.

3-10.1.8 Save Extended Recording

Data in the SPS390 extended record memory can be saved to a named disk file for

subsequent playback and analysis. The entire contents of the extended record

memory (time domain data) for all active channels is saved.

E= Save Extended Recording
File Name: Directories:
= xic} c:\sd390
‘ o e oy o]
= £d390
[+ =
+

Save File as Type: Drives:
[Xrecording Fites" XRC) [#]  [@c: S|

The extended record memory can be saved at any time. It is good practice to stop

acquisition before saving this data, although this function will automatically stop

acquisition (and averaging) if active.

The Save Extended Recording dialog will then allow you to name a file where the
data is to be placed. The data is stored on a disk file in binary format.

e

Extended recorder data cannot be exported.

The default directory and storage device is the current directory, C:/sd390.

The Save Extended Recording dialog allows three file type choices. These are:

r
»

>

XRC - internal format
.XUF - UFF format
XTX - Text format
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Operation (Continued)

- Save Extended Recording
File Name: Directories:
=wc c:\sd330 : "
< S — [__Cancel ]
P sd390
2 reynolds
-
Sava File as Type: Drives:
El
—1Ascu (= XTX)
UFF {(~XUF)

When UFF or Text formats are selected, up to 9 separate files are created; 1 file for
each active channel, plus a “container” file which is merely a description of the date
and number of channels saved in this data set. The container files are:

» <filename>.XUF (UFF format)

B

» <filename>.XTX (Text format)

The corresponding data files are:

» <filename>.XU1...8 (UFF format)
» <filename>.XT1...8 (Text format)

Each data file contains a single channel, in corresponding UFF or TXT Time format.
Whenever a new ‘set’ is created which will overwrite the existing ‘set’, the user is

prompted, and all previous channel files are deleted if the user wishes to replace a
data ‘set’. Individual channel data files can not be saved separately.

3-10.1.9 Load Averager Data

Averaged data that was previously saved to a named disk file is retrieved and loaded
into averager memory.

- Load Averager Data
File Name: Directories:
[ avg] c:\sd390 .
| 1 e -
= +d390
5]
Load Averager Data... List Files of Type: Drives:
averager Fiest"AvEL ¢ [=c e

When Load Averager Data is selected, the Analyzer is first put into HOLD. The Load

Averager Data dialog will then allow you to name the file from which to retrieve the
data.
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3-10.1.10 Save Averager Data

Whenever cross properties averaging is performed (by setting the Mode to Cross
Properties and performing an average measurement), the Save Averager Data option
is available. This allows you to save the active and reference channel power
spectrums, as well as the real and imaginary parts of the cross spectrum between
the active and reference channels. All standard Frequency Response Function (FRF)
displays, such as FRF magnitude, phase, coherence, and Nyquist, can be formed
upon recall of this data. This is a convenient way to save the FRF components for
later display and analysis, without having to display all (or any) of the FRF elements.

- Save Averager Data
File Name: Directories:
[m c:\sd390
avtust avy - et +] Concel
£ 2390

+
Save File as Type: Diives:
[Areagu Fiss"AVE] 2] [Bc 12]

rve Matetol Data
: . .

3-10.1.11 Load Waterfall Data

Data from the SPS390 waterfall memory that has been previously saved to a named
disk file is retrieved and loaded into the waterfall memory. The acquisition and
analysis parameters that were in effect when the data was saved are also restored.

- Load Waterfall Data
File Name: Directories:
= wil c:\+d330
| 1 .
P~ +d390
& L
5

List Files of Type: Drives:
[watedtal Filest wrL)_[3]  [=c: [#]

When Load Waterfall Data is selected, the analyzer is first put into HOLD. The Load
Waterfall Data dialog will then allow you to name the file from which to retrieve the
data.lb
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Data from a waterfall data disk file can be loaded at any
time. However, all current data and acquisition and
analysis parameters are replaced by the saved data and
saved parameters. These parameters may not be
compatible with the current settings and may invalidate
the current averager, and/or waterfall memory and
associated displays. Therefore, it's good practice to stop
acquisition before Loading this data, although this
function will automatically stop all acquisition functions if
active.

Waterfall data cannot be exported.

The default directory and storage device is the current directory, C:/sd390.
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3-10.1.12 Save Waterfall Data

Data in the SPS390 waterfall memory can be saved to a named disk file for
subsequent playback and analysis. The entire contents of the waterfall memory
(selected waterfall analysis function) for all active waterfall channels is saved.

= Save Waterfall Data
File Name: Directories:
IEI c:\sd330 -
]
» e\ >
P «d390
[+]

Save File as Type: Drives:
[Watertall FlesWFL) (3] [ (2]

The waterfall memory can be saved at any time. It is good practice to stop
acquisition before saving this data, although this function will automatically stop all
acquisition functions if active.

The Save Waterfall Data dialog will then allow you to name a file where the data will
be placed. The data is stored on a disk file in binary format.

3-10.1.13 Print

The Print Dialog is used to add a title, comments, select display windows and
provide a mechanism to cancel the print dialog before a print command is issued.

Batch plot prints a copy of each selected SPS390 display to the attached printer or
other hard copy device.

To Invoke Printing

To invoke the Print Dialog box:

» Use the trackball to:
Select the File menu,

and then Select Print

Selecting Print from the File Menu will invoke the print dialog.
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Operation (Continued)

The SPS390 analyzer display will cease to update at this
point. However, internal signal processing functions such
as memory loading or averaging will continue behind the
scenes. This will allow you to make changes to the Title or
Comments section without stopping the signal processing.
However, these signal processing functions will stop when
the print command is issued.

: m Print Dialog
Title:
l Print
! @ Batch Plot C: Dual Plot
Print Information
f [T A-Mag Spec-L1 [T D-Mag Spect2 7 5
™ B-Time-L1 [~ E-Mag Spec-Al [ i Cancel
[T C-TimeL2 X F I el

Comments:

BO6LH-25

Make the appropriate selections on the Print Dialog and then either select Print or
Cancel. Cancel will cancel any entries or selections that were made and the last
SPS390 display will be activated again. Selecting Print will start the print process.

- Display Print

@ Print In progress.
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If you invoked the Print dialog, to make changes to the
dialog, while the process to be printed was in progress,
immediately select Cancel from the Display Print page.
This will invoke the changes made and retain them for a
subsequent selection. Selecting Cancel will restart the
analyzer display and you can take note of the process that
was being performed while the changes were made to the
Print Dialog.

If you have selected Background Printing on the Windows Printer Setup you will have
a very brief time to select Cancel on the Display Print dialog. Once the Display Print
dialog disappears and the SPS390 display returns, the Print Manager is the only
method to cancel a print before or during the actual printing process.

Print Dialog and Printer Settings

The print dialog works in conjunction with the printer settings that you select in the
Windows operating system. There are only two major changes that can take place
on the printer settings of the Windows operating system, Portrait or Landscape
formats for the paper. Within the SPS390 Print dialog there are three formats that
can be selected: Batch Plot, Dual Plot and Plot plus List. Plot plus List is a default
subset of Batch Plot and is not available when Dual Plot is selected.

Batch Plot will print all selected displays to be printed in order. Remember if you
have selected Batch Plot you have invoked a series of single plots to go to the
printer. If you change your mind and want to Cancel the printing process you will
have to Cancel each and every plot that was selected.

Dual Plot will allow two selected displays to be printed one above the other as
selected by the operator.

Plot plus List will only be available if the operator has previously selected a Marker
List for the selected display to be printed. If the Marker list has not been invoked it
will not be provided regardless of the fact that markers may appear on the display.

The eventual printed form will change its appearance in accordance with the
following rules.

Portrait

Batch Plot will plot a single plot per page with the Title at the top and the Comments
on the bottom of the page.

Dual Plot will allow two plots per page. The Title will appear at the top of the page
and the Comments will appear at the bottom of the page. Therefore, any comments
entered should be common to both plots.

Plot Plus List will print a single plot per page and if a Markers List has been invoked
the listed points will be provided in the lower half of the page below the plot.
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Landscape

Batch Plot will plot a single plot per page with the Title at the top and the Comments
on the bottom. This is the largest printed plot available.

Dual Plot is not available in landscape format.

Plot plus List is not available in landscape format.

Title and Comments

Any text entered into the Title or Comments lines of the Print Dialog will remain as
entered until changed by the operator. The entered text will even remain in
subsequent sessions of SPS390 sessions even if power is removed.

D SPS390 HINT When a number of plots are going to be produced, to
document a measurement process on a single item or a series of
items, keep the identifiers you enter in the Title and Comments
near the beginning of the text so that incremental changes to the
sequence can be made easily. i.e. Plot X of Item Y First Production
Run Vibration Test. Where X is the number of the plot and Y is the
serial number of the item being tested. In this example, the
operator only has to retype the X and the Y for all the plots
produced.

Print Date and Time

There is no need to enter the date and time for any printout from the SPS390. Date
and Time is an automatic process of the software. The data being printed has a date
and time entry as to when the data was taken and the printout has a date and time
of when the print is performed. The date and time of when the print is performed
shows up on the same line as the Title line on each printed form.

Other Print Capability

The SPS390 and the standard Windows tools allows for screen capture using the
standard 101 keyboard print screen command. This action places the entire
SPS390 display screen on the Windows clipboard as a bit mapped (.BMP) file. This
BMP file can then be imported directly into other Windows programs that support
the importation of .BMP files.

There are a number of more elaborate screen capture programs available for
Windows programs and allow for more sophisticated screen captures.

It is important to note that printed data from a bitmap file
can be altered in programs such as Microsoft Paintbrush,
whereas the prints from the SPS390 print selection cannot
be altered.
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SPS390 Marker Plus List Presentation

A-Mag Spec-A1
2 1,00
)
2.00
=T
i *
g A%)] N
o
3.00 3 —
Vp
T :
1 t X
Jan 1 g
m T 507
it ¢ ! : !
il i - s R N Y § - ar-9°
T : = 3 1S ¥ ;4 o g
; f 1 it i i
i 1 BRI ! 1 | i fr
A 1 ‘ i f "
100 | 1 L L L ’» | B
Hz

0
X:460.7 Y:1.004 OA:1.008 vp THD: 8.80%

Ch 1 Fult Scale : 1 Vrms

Digplay | Magnaude Spectrum
Cal Factor . 100mV/EU

Frequency Span . 4 KHz

Resolution : 400 Lines
Weighting | Hanning
Overiap | MAX

HARMONIC MARKERS: Fundamental Frequency { 460.0 Hz )

Marker # X{Hz) Y{(Vp)
1 4607 1.004
2 921.4 85.87m
3 1.382k 13.93m
4 1.843k 24 81m
5 2.304k 1.881m
[ 2.764k 3.695m
7 3.220k 352.7p
8 3.680k 889.9u

Domain | Cross Properties

Method | Exponential

AVG Count - 10 of 10

Acquired - 05/08/88 11.26

Marker Type | Orders

E13

NOTE: Harmonic presentation with marker annotation and marker listing.

Marker Plus List feature is only available in portrait printer mode.

The cursor X/Y interpolate features was selected.

CAG -
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3-10.2 Setup Menu

The following parameters can be set, modified, and examined by selecting the

appropriate topic from the Setup Menu.

3-10.2.1 New Display

Invokes the Display Setup dialog to specify the settings for a new display.

‘Display

Display Setup

Function !Magnitmle Spectrum

i L;j " Source- I '
“ O Live C Store Math...
@ Average C Waterfall

I~ Tics & Grids

|

Ch Is

Annotation— -

X-Axis - Y-Axis

Units Units

Hz [¢] o8 [
@ Linear C Log Iny/Diff

I Interpolate XY Values

o T

C Linear ® Log
F* Tics ® Grids

_ 12
Active @& C

4
OK Cancel

3-10.2.2 Acquisition

Invokes the Acquisition Setup dialog to change the SPS390 data acquisition

parameters.

Acquisition Setup

Trigger—

Source

lFrce Run ]

Channels
Coupling FS rms mV/EU EU Name db Ref V Ret
1jac o] v e [force [0 o
2fac 3] 2vE][iee [units o [o

Sampling Method -

ilntcmal ‘:1 I~ Zoom Mode

™ RPM Readout
Frequency Span

axnz[E] oK
Pulses Per Rev
‘ 1.000 Cancel
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3-10.2.3 Analysis
Invokes the Analysis Setup Dialog to change the SPS390 analysis parameters.

Analysis Setup

Anput - - o
1 2 3 4

Active R R [
Reference ® [

Block Size !ﬂ)?l samples, 400 lines H Overlap !MAX ]

Channel

Pracess Weighting !Hanning Ej
Memory 120832 samples g
‘Ave‘l’age B 7
Domain Cross Properties 0K
Method m
Avg Criterion 3C0|lnt LtJ ! ZOB Ensembles Cancel

3-10.2.4 Waterfall

Invokes the Setup Waterfall dialog to configure the SPS390 waterfall analysis
parameters.

Setup Waterfall

1 2 3 4 5 6 7 8
: Active [
Channel OK
Reference @
Function
.. Source -
Mode Cross Properties @ Live
P Cancel
 Type lMagnitude Spectrum Lt_] - O Average
Control
Load Method
Continuous L!j ’Cnntinuous {Ej
Records{Channel
10 £
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3-10.2.5 Preferences

Clicking on Preferences on the Setup menu invokes the Preferences dialog. This
allows the user to control some display configuration elements and other features.
For example, control buttons can be displayed at the top or bottom of the screen.
{(Top is the default.)

Preferences

I” DDE Server Capability:

& Display Buttons

Preferences.. ® Controls On Top

R Overload Audio Tone h“““ Hz

™ Shorthand Notation

™ Peak Interpolation

OK Cancel

DDE Server Capability

Clicking in this box activates the dynamic data exchange server, allowing the
exchange of data between the SPS390 and other Windows applications.

&= See section on dynamic data exchange.

Display Buttons

When this box is clicked, the buttons along the right-hand edge of the display are
shown. (These buttons are labels for the function keys on the SPS390 front panel,
and also function independently as on-screen buttons.) If the box is not clicked,
these buttons do not appear. However, the function keys remain active at all times.

Controls on Top

This button determines whether the control buttons are displayed at the top or
bottom of the screen. Where these buttons are displayed is a matter of personal
preference. The default is to display them at the top.

Overload Audio Tone

When this box is checked, an audio tone is emitted whenever an overload condition
occurs. The frequency of this tone can be set by typing in the desired value in the
box. to the right. (The default tone is 1000 Hz.)

Shorthand Notation

This selection provides a choice of standard or “shorthand” notation on the cursor
readouts. Standard cursor notation uses prefixes that present the greatest possible
dynamic range (milli-, kilo-, micro-, Mega-, etc.). When shorthand notation is used,
“real” values are shown for both X- and Y-axis cursor readouts.
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Note the differences in cursor readout in the following two displays. The
“shorthand” readout always uses a real number, less any decade or x 1000
multipliers. X-axis resolution is actually increased up to as many as 5 digits in Hz,
or 7 digits in CPM, and amplitude values can have as many as 9 digits for large
values and down to 0.001 for small values.

A Mag SpecL1

""Standard Notation"

""Shorthand Notation"

o

5

0 A ..“J\ A AJL Ao A oona oN R
0 CPM 0000

X:57421 v:0.068 OA:0.762 Gp
A ==

Peak Interpolation

When this box is selected, the peak frequency and amplitude interpolation feature is
activated. This feature should be used whenever pinpointing the exact frequency of a
signal is important, and when time is of the essence. It is especially useful in
applications such as diagnosis of very complex machinery vibration spectra. The
effect of interpolation can be an improvement in frequency resolution of orders of
magnitude, without the typical time loss associated with longer block lengths or
zoom (which are sometimes used to accomplish the same objective). With this
improvement in resolution, there is no loss of amplitude accuracy, since the correct
peak value is interpolated based on the characteristics of the Hann window.

The advantages of using peak interpolation are well illustrated in the following
example:

" A‘Mag Spec-Ll

Gp

EiEkkls B

] JIL.J;JIJ_JJW&M a0 o
CPM

120000

0
X:5666 v:1. 604 0A:2.6853 Gp THD: 133.58%

When these harmonic markers are Listed, the frequency and amplitude may appear
as shown in the following list. (See Markers Setup in section 3-11.7 for information
on listing markers to the Notepad.)
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Operation (Continued)

A-Mag Spec-L1,

CONGVIEWN =

18
19
29

5666
11332
17004
22659
28340
34004
39679
u5347
50935
56623
62361
67993
73800
792088
84778
o854y,
96300

181860
1077080
113386

64/03/94 12:32:21,
CPM
cPH
CPH
CPM
CPM
CPM
CPM
CPHM
CPM
CPH
CPH
CPM
CPM
CPM
CPM
CPM
CPM
CPM
CPM
CPM

Harmonic Markers

1.604
0.782
0.531
0.276

0.47
0.388
1.032
1.168
0.392
0.585
0.404
0.643
08.336
0.192
0.862
0.034
0.011
0.033
0.042
0.048

Note that here the FFT bin spacing is 300 CPM, yet with Interpolation selected, the

effective marker resolution is virtually +1 CPM.

The following Notepad listing shows the same set of harmonic markers, but this time
Interpolation was turned off. Note that each of these is set on 300 CPM bin-centered

values

A-Mag Spec-L1,

CQAONOVIEWN«

5700
11400
17100
22800
28500
33900
39600
45300
51000
56700
62400
68100
73800
79500
85200
908600
96300

1020860
107700
1134006

04/703/98 12:47:03,
cPM
CPH
CPHM
CPM
CPM
CPM
CPM
CPM
CPM
CPM
CPHM
CPM
CPM
CPH
CPM
CPM
CPM
CPM
CPH
CPH

Harmonic Markers

1.59
0.757
0.497
0.239
0.391
9.358
0.987
1.149

6.38
0.484%
0.399
8.593
8.336
0.219
0.009
0.033
0.011
0.028
0.042
0.045
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Operation - Dialogs (Continued)

3-10.2.6 Display

Invokes the Display Setup dialog to modify the settings of the currently active

display.

Display Setup

Display
Source
Function lMagnlmde Spectrum H C Live ' Store N
’ Math...
@ Average ¢ Waterfall
Annotation - -~ e .
X-Axis Y-Axis
Units Units
Hz BRI [¢]
& Linear  Log InyDitf
I Tics & Grids !Nomul !:]
' Linear ® Log
: " Tics M Grids
I Interpolate X/Y Values
ch 1s.
12 3 4
Active & O OK Cancel

3-10.2.7 Markers

Invokes the Markers Setup dialog to select and list markers for a specified trace.

Class

A

Markers Setup

lHarmonics Ifj

oK

fFr
q

Frequency ‘201.783 Hz

T

Cancel

Curs Val

List

i

Harmonic #1

el ]

3-10.2.8 Noise Generator (Option)

Invokes the Noise Generator Setup dialog to set parameters for a random signal
source output, and to initialize signal output.

Noise Type Gt0]]

Output Level 800m\; rms‘ %

Noise Generator Setup

OK

Cancel
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Operation (Continued)

3-10.2.9 Sine Generator (Option)

Invokes the Sine Generator Setup dialog to set parameters for a swept or dwell sine
- signal output, and to initialize signal output.

Sine Generator Setup

Sine Type

OutputLevel  B0Omv pk_ &
Start Freq 166 Hz
End Freq W Hz
Sweep WEJ
& Lin 180 Hz{Sec
C Log

Cycles 50 ) %

0K } Cancel

3-10.2.10 Modal Apps (Option)

Invokes the Modal Control setup dialog to specify parameters and initiate saving FRF
data in SMS modal or UFF format.

When Modal Apps is selected, button F10 in the lower right-hand corner of the
display will change to a button labeled Modal. Click on that button to bring up the

Modal Control dialog box.

Qe
v Modal Apps.

Input
Channel
Location

Fixed Loc

Meodal Control

Auto
r

™ Increment

™ AVG Restart

Project

Measurement Type

™ Freq Resp

[ Coherence

1 2 3 4 5 6 7 8
fiIx o ex 3 jax

r i I m

Coord Type Degrees Of Freedom
@ Rectangular o [—‘——— ’ o OK
C Cylindrical Direction  |X
C Spherical Increment 1
C Mixed @ Set {|Cancet

Directory... l

- Unassigned -

™ Crass Spec

™ Autopower

Save as SMS file |*
Save as SMS file

Save as UFF file
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Operation - Dialogs (Continued)

3-10.3 Mode Configuration Menu

The Mode Configuration Menu controls the “personality” of the analyzer. Selecting
the appropriate mode configuration affects the types of analyses and displays that
can be produced and determines the resource utilization of the SPS390. Careful
selection of the mode configuration allows a balance between required analysis
functions and optimal real-time rates.

Mode Configuration

Mode
lCross Properties L!J

% waterfall Cancel
EDSP Memory Allocation

‘Total WFL Records Total Input Samples |
1002 665600

ik L1 2]

3-10.3.1 How To Invoke Mode Configuration
To invoke the Mode Configuration dialog:

» Use the trackball to:
Select Mode from the main menu
or

» Use the keyboard and:

Hold down the ALT key and press the M key

Analyzer mode parameters are not set until the OK button at the upper right corner
of the dialog is pressed. Selecting Cancel causes the dialog to disappear without
affecting the mode parameters.

3-10.3.2 Mode Configuration

The list of available modes appears in the pull down Mode combo box. You may
select the desired mode by highlighting and clicking on the appropriate mode item.

Made Configuration

Made

Cross Properties
Correlation
Cross Properties
Octave
Spectrum

Sync Spectrum [otal Input Samples
1002 665600

Ll I s

l‘ OK

Cancel

The four standard Mode selections are:
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Operation (Continued)

Correlation

This mode allows correlation measurements, which can be used to understand
certain signal relationships in the time domain and also can give an accurate
assessment of signal delay time between two observation points.

Cross Properties

This is the default mode which results in the most versatile use of the SPS390 in
spectrum mode, in that power spectrum and cross property data (transfer functions,
cross spectrum, etc.) is available, and almost all analyses and displays (except for
sync spectra} are available.

Spectrum

This mode is used when only time and power spectral data is required. It conserves
internal resources, and allows very high real time rates for live and averaged
spectral processing.

Sync Spectrum

This mode is used when time synchronized averaging is required. This mode must
be enabled for synchronous spectrum displays as it enables time averaging.

&= If the Octave Analysis Option is installed, the Octave Mode selection also
appears.

Octave

This mode enables octave analysis in place of spectrum analysis. Discrete digital
filters are used to compute the amplitude levels of the selected bands.

The Analysis Mode will also automatically select the averager domain. This
determines the types of analyses and displays that can be produced.

See data sources in the display dialogs_for more information.

The availability of certain trace displays is affected by the
current mode. The factory default Mode is set for Cross
Properties. See the table in the description of the Display
Setup dialog’s display type control.

The real time rate of the SPS390 is controlled by careful
selection of the analysis mode. For the fastest real time
spectrum analysis rates, set the domain to spectrum. Of
course, the prime determinant of the domain setting is the
type of analysis required.
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Operation — Dialogs (Continued)

3-10.3.3 Waterfall Mode Enable Check Box

This check box enables or disables Waterfall Mode. When enabled, data can be
processed and loaded into the waterfall memory and recalled (or played back) from
the waterfall memory.

Mode Configuration

Mode e :
; 0K
lCross Properties I}_J
—— | K Waterfall Cancel
DSP Memory Allocation-—-
Total WFL Records Total Input Samples

1107 897024

L] L] [+].

3-10.3.4 DSP Memory Allocation

The amount of available analyzer memory can be divided between XRec memory and
waterfall memory when the Waterfall mode is enabled. This control proportions the
maximum amount of available memory between extended recorder use and waterfall
use. The desired amount of memory per channel (up to the maximum allocated
from this control) for the extended record is set on the Analysis Setup dialog box,
and the amount for waterfall is set on the Waterfall Setup Dialog box.

The total amount of memory is shown in Total Input Samples available for extended
memory and the Total WFL Records (at the current block Size) for waterfall memory.

&= See section 4 _for additional XRec memory information.

The Analysis Setup and Waterfall Setup dialog boxes allow

selection of these parameters in samples per channel or
records per channel.
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Operation (Continued)

3-10.4 Window Menu
3-10.4.1 Cascade

Organizes the display windows so that they stack-up one atop another but with the
title bar and left-hand edge of each display window being visible as shown.

Signal Processing Systems ﬂﬁ]
File Setup Mode Window Help Tools
: = A[-)T:I':a:gpec-m %_ %
1 C-Mag Spec-A2 {a]
. —lE ; 1
PAAARARAAAARAAARAAI ] (o
BRI A RURYRERARERRRNRN =]
x4 Ol 400 [D
==——2 " 0 Seconds 8E]m[I i
883 : 2K
12713196 17:19:19 8,006 RPM 10 0
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Operation - Dialogs (Continued)

3-10.4.2 Tile Horizontally

Tiles all display windows horizontally within the frame window by moving and
resizing them so that no display windows overlap one another and all area within
the frame window is used, as shown in the following example.

Al

T ntally

=3 anal Pro

File Setup Mode Window Help Tools

1 » A K

=| ATFPhaa2t  [~]-lifl=] DTFImaz2n  [+]«l§[=] FIFconazn [~]<] By
180 [ 5 ~ 1 R r’" ) _TL:]
g%,f : W@ _____ - :@ - I S [al|f | et
Ll “* “ L “
on S =R A Ele
B i RESUE
14 ] (0] (@] | | =
180N il s (b A e | srene
0 Hz 4k 0 Hz 4k 0 Hz 4k —
X:490.0 Y:-91.48 %:430.0 Y:-4.755 %:490.0 Y:983.4m “!
=| B-TF Mag-A2/1 |~vi«ili= Re-A viaflla E-Nyqst-A2{1 via
AN : =
el [a] &l 7
2l ol L c
P ONCTT _‘_,__,@ S @ S @ F8
TN @] wl o @ 5]
1 (R : ” Fo
" 0 — :J — 4k * 0 H )4k s 5 VA 5 I:j] \
2 2 -
X:490.0 v:4.765 X:490.0 ¥:-122.7m X:-122.7m ¥:-4.755 (0] F10‘
2 [ 1 P ‘
A el = k
12/13/96_17:29:41 20
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Operation (Continued)

3-10.4.3 Tile Vertically

Tiles all display windows vertically within the frame window by moving and resizing
them so that no window overlaps another and all area within the frame window is
used. Refer to the following example.

Window

B A-TF Im-A2]1 [=1-]
10 g 20
§ 0 / § {"'
f
~{[a]l B
| 3| ]
s - s]
D]l D]
10 il 2 1]
0 Mz 4k ! g Hz 4k
X1 Pk Y7 14R 181 Rk Y13 R3

Display windows are tiled in the opposite order in which they are made active (a
display window is made active by clicking anywhere on it). The following diagram
illustrates this process.

ATC AL D B
B D -’Biy ==Cc =

/l\ A
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Operation - Dialogs (Continued)

3-10.4.4 Display Window List

A list of all display windows appears at the bottom of the Window menu, separated
from the other items by a solid black line. Clicking on one of the titles will make the
corresponding display window the active display window and make it visible if it is
hidden or iconized.

Window

3-10.5 Help Menu
3-10.5.1 Index

This selection invokes the SPS390 on-line manual, beginning at the main index.

” .S[i3.f‘].ll]nliielp

History

Index of Topics
SD290 Reference Guide
Index Of Topics

Introduction
OVErdEw
Geting Started
Cperating Modes
Edended Fecorder Memaory
Waterdall Memory
Diata Buffers
YVirtual Kevhoard

Main Menu

Oy
Fig
SRin

Morle
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Operation (Continued)

3-10.5.2 Using Help

The Using Help selection invokes the Microsoft Windows help system user’s manual.
Use this if you have any questions about the help system.

3-10.5.3 About SPS390

The About SPS390 dialog displays the hardware configuration of the SPS390 plus
the application system version number, as well as the date and time the application
version was created.

If you have any question about the configuration of your particular SPS390, refer to
this dialog. This dialog can also provide useful diagnostic information concerning
the operation of the hardware, and can indicate possible incompatibilities when
transferring files from one machine to another.

When finished, click on the OK button at the bottom right corner of the dialog.

Version 3.7C Standard, Jul 22 1936
4 Analog Channels Installed
8 MB of DSP Memory Installed

Analog Board Type 1-1
‘Digital Board Type 1
10 Board Type 1

EO65H-C6
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Operation — Dialogs (Continued)

3-10.6 Tools Menu

The Tools menu permits quick access to up to ten Windows™ programs or routines.
Frequently used tools can be activated by a single mouse click, without leaving the
SPS390 program.

Signal Processing Systems
dow Help REIIE

Calculater

Clock 0
Paint Shop Pro
BalancePRO

Word

Excel

sp11g [y

Signal Stats

Pong

In order for a tool to appear in the Tools menu, it must be inserted in the 390.ini file.
Typically, the tools revert to the background during normal SPS390 operations.

Example:

A otepad D390

Jf File Edit Search Help

[Debug]
Printf=16384
Errfile=c:\sd390\sd398.err

[Settings]

DDEEnabled=1

OverloadTone=1009
Tool1=Notepad,NDIEPRD,c:\windows\notepad.exeI
Tool2=Calculator ,SCICALC,c:\windows\calc.exe
Tool3=Clock,CLOCK,c:\windows\clock.exe
Tools=Paint Shap Pro,PSP,c:\WINDOWS\PSP\PSP.EXE
Tool5=BalancePRO,Bal,c:\matlab\bin\matlab
Toolé=Word,word,c:\word
Tool?=Excel,excel,c:\windous
Tool8=SD119,SD119,c:\windows

Tool9=Signal Stats,sigstats,c:\windows
Tool18=Paong,pong,c:\windows

ShortHand=8
PeakInterp=0
Uisible=1

. i

In the example shown, ten tools have been inserted into the Tools directory. When
you click on a Tool name — Clock, for example — that application appears on the
SPS390 screen, and can be moved or modified to any position or size desired. To
return to the standard SPS390 screen, click anywhere on the SPS390 page.
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Operation (Continued)

=

Signal Processing Systems

File

Setup Mode

Window Help Tools

e 0 v |a

| Settings

9:37:90 PM
12/13/96

GOBHH-07
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